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1 What’s New in This 
Update of the User 
Guide?

TIP: Need help? Send an email to cmecf_ca9help@ca9.uscourts.gov and please include 
information such as case numbers, filer's name, and any other information that can assist us in 
answering your question. You can expect a reply from the Court during the Court's business hours, 
from 8:30 AM to 5:00 PM Pacific Time.

This topic lists the additions and updates that were incorporated in each update of this guide.

January 9, 2009 Updates
• Updated “Filing Categories and Types of Motions” on page 69 to reflect changes in labels of 

filing categories and types and to include new filing types

• Category changes:

• Court Reporters/Transcripts renamed to Transcripts/Court Reporters

• Filing type changes:

• File Correspondence to Clerk Related to Pending Case (9th Cir.R.25-2) renamed to 
File Correspondence to Court

• File Court Reporter Correspondence to Clerk Related to Pending Case renamed to 
File Court Reporter Correspondence to Court

• (New filing type) In the Briefs category, added File an Errata to a Brief

• (New filing type) In the Rehearing/Reconsideration category, added File a Reply to 
an Answer to a Petition for Rehearing/En Banc

• Updated “Checking the Service List for a Case” on page 39
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What’s New in This Update of the User Guide? >  
November 8, 2008 Updates - Version 2.1
• Updated “Screen Resolution” on page 16

• Updated: “Completing an Electronic Filing” on page 24

• Updated: “Selecting the Filing Party” on page 31

• Updated: “Attaching PDF Documents to Filings” on page 36

• Updated: “Submitting a Brief for Review by the Court” on page 41

• Updated: “Types of Motions Available When Submitting a Brief and Filing a Motion Together” 
on page 71

• New: “Creating Cross-Document Hyperlinks” on page 59

September 18, 2008 Updates
• New: “Filing a Motion and a Response to a Motion Together” on page 49

• Other minor updates throughout the guide.

September 9, 2008 Updates
• New: “Submitting a Brief for Review by the Court” on page 41

• Updated: “Filing a Motion” on page 45 (minor updates)

• New: “Filing Categories and Types of Motions” on page 69
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2 Getting Started

The topics below provide information that you may find useful when using ECF in the United 
States Court of Appeals for the Ninth Circuit.

• “Typographical Conventions Used in This Documentation” on page 8

• “ECF Application Overview” on page 9

• “Supported Browsers” on page 10

• “Starting ECF” on page 11

• “Stopping ECF” on page 14

• “Updating Your Account Information” on page 15

• “Screen Resolution” on page 16

• “Windows in ECF” on page 17

• “Drop-Down Lists” on page 19

• “Radio Buttons” on page 20

• “Date Fields” on page 21
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Getting Started >  Typographical Conventions Used in This Documentation
Typographical Conventions Used in This 
Documentation
This documentation uses the typographical conventions described in Table 1.

Table 1. Typographical Conventions

Formatting Description Examples

text Fixed Courier font.
Used for text that you must type in exactly as 
shown, for keyboard keys that you must press, 
for predefined values in drop-down lists.

In the Confirm field, type YES.

Press Alt-F1.

text Bold.
Used for labels in the user interface of ECF, 
such as area labels, field names, and button 
labels.

From the Category drop-down list, 
select Motions.

text Italic.
Used for variable information that you must 
enter in ECF. Also used for new terms when 
they are first defined in the guide.

In the Attorney field, type the name of 
the attorney for the case.

In the Date field, type today’s date.

In ECF, the File Date is the date that the 
Court considers something filed.

> Greater than sign.
Used to indicate a navigation path in menus.

Choose Reports > Service List.
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Getting Started >  ECF Application Overview
ECF Application Overview
Case Management/Electronic Case Files (CM/ECF) is an automated case management and 
docketing system designed specifically for the federal courts. The case management and docketing 
(CM) portion is used by the courts. The electronic case files (ECF) portion allows courts to manage 
documents electronically; provide 24-hour desktop access to case files by judges, court staff, and 
the public; and accept filings over the Internet.

Electronic case files are documents stored in electronic format instead of on paper. Documents can 
be created electronically by parties and court staff or paper copies can be scanned. All documents 
are stored in Portable Document Format (PDF).

The ECF portion of the system is easy to use and allows a court to store, retrieve, review and send 
case documents in a reliable and secure electronic format. ECF also offers the following benefits:

• Twenty-four hour access to case files from any location

• Remote document filing

• Concurrent access to files

• Immediate e-mail notification of case activity to parties and court staff 

• Easy public access

• Secure storage of documents
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Getting Started >  Supported Browsers
Supported Browsers
ECF has been tested successfully using Firefox 2.0, and Internet Explorer 6 and 7 as representative 
browsers. All testing was performed using the Java Plug-In version 1.6.

For additional information about technical requirements, please see What hardware and software 
will attorneys need to participate in CM/ECF? in the ECF Frequently Asked Questions page at 
PACER (http://pacer.psc.uscourts.gov/cmecf/ecffaq.html).
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Getting Started >  Starting ECF
Starting ECF
After you log in to ECF, the Startup Page window opens. 

1. Open a web browser window and navigate to the following URL:
https://ecf.ca9.uscourts.gov/cmecf/servlet/TransportRoom?servlet=Login 

The Appellate CM/ECF Login page, shown in Figure 1, opens.

2. In the Login field, type your Appellate ECF login name and in the Password field, type your 
password.

NOTE: The Login and Password fields are case-sensitive.

3. (Optional) In the Client Code field, enter a code to identify the person using the account.

This information is only referenced by PACER.

4. Click the Login button.

5. If a Security Information dialog box opens, click the Yes button.

Figure 1. Appellate CM/ECF Login Page
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Getting Started >  Starting ECF
The following happens:

a. A browser window, shown in Figure 2, opens. 

This window, which remains open in the background, is titled CM/ECF Appellate and the 
top of the page reads “U.S. Court of Appeals CM/ECF”. The large CM/ECF button initially 
appears with an orange Java logo. Wait until that logo disappears and the button contains 
the text CM/ECF as shown in Figure 2. 

CAUTION: Do not close this window at any time. 

b. The Startup Page window opens in the foreground. 

An example is shown in Figure 3 on page 13. Notice that your last login date and time are 
shown near the middle of the page.

CAUTION: Do not close the Startup Page window at any time.

Figure 2. CM/ECF Appellate Browser Window
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Getting Started >  Starting ECF
Figure 3. Startup Page Window
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Getting Started >  Stopping ECF
Stopping ECF
To ensure that the different pieces of the application close correctly, you should always logout from 
ECF.

1. From the menu bar of any active ECF window, choose Logout > Logout CM/ECF.

A Confirm Logout dialog box, shown in Figure 4, opens.

2. Click the Yes button.

ECF logs you out and closes all its windows.

Figure 4. Confirm Logout Dialog Box
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Getting Started >  Updating Your Account Information
Updating Your Account Information
The quickest way to update your account information is to navigate to the Appellate Filer Account 
Update page and submit your changes. Use this URL to get started: https://pacer.psc.uscourts.gov/
psco/cgi-bin/cmecf/ea-login.pl.

You can also access the Appellate Filer Account Update page from within ECF:

1. From the menu bar of any active ECF window, choose Utilities > Update My Account.

The User Account Profile window opens. An example of this window is shown in Figure 5.

2. Click the Edit My Information button.

A new browser window opens with the Appellate Filer Account Update page.

Review the Frequently Asked Questions accessible from this page to answer any questions you 
may have about updating your appellate ECF filer account information.

Figure 5. User Account Profile Window
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Getting Started >  Screen Resolution
Screen Resolution
The minimum screen resolution required to run ECF is 1024 x 768 pixels. If the screen resolution 
for your workstation is lower, you must change the resolution before you start using ECF. You do 
not have to make any changes to your screen resolution if the current setting is higher than 
1024 x 768 pixels.

CAUTION: If you do not adjust your screen resolution, you may not see all the information you 
need to see in order to enter a filing in ECF. 

For example, when you click the Continue button at the File a Document screen, the system will 
open a warning dialog box that you need to review in order to continue the filing. Each warning in 
that dialog box has a corresponding Continue checkbox all the way on the right of the dialog box, 
and you may not be able to see those checkboxes if your screen resolution is not high enough. In 
order to proceed with a filing, you must select each Continue checkbox before clicking the OK 
button.

Another possible issue may be that you do not see all the messages in the warning dialog box, in 
which case you may need to use the scrollbar on the right of the dialog box to see all the messages.

An example of a complete warning dialog box is shown in Figure 6. In this example, you would 
have to select the 5 Continue checkboxes and then click the OK button to proceed with the filing.

Figure 6. A Warning Dialog Box in ECF
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Getting Started >  Windows in ECF
Windows in ECF
In ECF, most windows are divided into several parts: a title bar, a menu bar, a screen area, and an 
area at the bottom of the window that contains command buttons. An example of a window is 
shown in Figure 7. 

Figure 7. A Window in ECF
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Getting Started >  Windows in ECF
Title Bar
The title bar contains the following elements: the ECF icon, the title of the window, and the 
standard window controls (minimize, maximize/restore, and close).

Menu Bar
The menu bar contains a number of menus that contain commands. In Figure 8, Docketing, 
Reports, Utilities, Logout, and Help are menus. Notice for Cases of Interest and Update My 
Account are commands or menu items.

Command Button Area
The command button area contains the buttons that let you continue or step back in a process.

In most cases, you can also use the Cancel button in this area to cancel the process you are 
currently working on. An example of a set of command buttons is highlighted in Figure 9.

Figure 8. Menu Bar

Figure 9. Command Buttons
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Getting Started >  Drop-Down Lists
Drop-Down Lists
A drop-down list contains a set of predefined values. In Figure 10, there are two drop-down lists, 
Category and Description. The Description drop-down list is the active drop-down list (the 
values that you can select are visible).

To select a value in a drop-down list
• Using the mouse, click the down arrow of the drop-down list and select a value in the list.

• Using the keyboard, type the first characters of the value to select the first matching value in 
the list.

• Using the keyboard, use the up arrow ( ) and down arrow ( ) to navigate up and down 
in the list and select the highlighted value in the list.

Figure 10. Drop-Down List
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Getting Started >  Radio Buttons
Radio Buttons
A radio button is a control that you turn on by selecting the radio button. Radio buttons are mutually 
exclusive. This means that if you select one radio button in a group, you will not be able to select 
another radio button in that same group. In some cases, selecting a radio button changes the other 
user interface elements in the application. 

Figure 11 shows two sets of radio buttons. The set on the left represents categories, the set on the 
right represents a type of filing. In Figure 11, the Motions/Responses/Replies radio button and the 
File a Motion radio buttons are selected.

Figure 11. Radio Buttons Example
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Getting Started >  Date Fields
Date Fields
A date field is a field where you must enter a date in one of the following supported formats:

• mm/dd/yy or mm/dd/yyyy 

Example: 7/2/07 

• mm-dd-yy or mm-dd-yyyy 

Example: 7-02-2007 

• mm.dd.yy or mm.dd.yyyy 

Example: 7.2.07 

In ECF, you can also fill in a date field by selecting a date from a pop-up calendar.

To use the pop-up calendar to fill in a date field
1. Make the date field the active field, right-click and choose Select Date from Calendar from 

the pop-up menu.

A pop-up window opens with a calendar, as shown in Figure 12.

Figure 12. Calendar Pop-Up
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Getting Started >  Date Fields
TIP: Use the navigation buttons at the top of the calendar to quickly view the calendar for 
another month and year.

• Click the << button to go to the previous year without changing the month. In the example 
in Figure 12, clicking the << button would show September 2006.

• Click the < button to go to the previous month. In the example in Figure 12, clicking the < 
button would show August 2007.

• Click the > button to go to the next month. In the example in Figure 12, clicking the > 
button would show October 2007.

• Click the >> button to go to the next year without changing the month. In the example in 
Figure 12, clicking the >> button would show September 2008.

2. Click a date to fill in the date field from where you invoked the calendar.

The calendar pop-up closes.
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3 An Overview of Filing

The topics listed below describe the process of filing in ECF. In ECF, you use the Docketing menu 
to start filing a document.

• “Completing an Electronic Filing” on page 24

• “Finding and Selecting the Filing Type” on page 30

• “Selecting the Filing Party” on page 31

• “Selecting Related Previous Entries for a Filing” on page 34

• “Selecting Reliefs for a Filing” on page 32

• “Attaching PDF Documents to Filings” on page 36

• “Checking the Service List for a Case” on page 39
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An Overview of Filing >  Completing an Electronic Filing
Completing an Electronic Filing
You start the filing process by opening the File a Document window.

1. From the Docketing menu, choose File a Document.

The File a Document window, shown in Figure 13, opens.

Figure 13. File a Document Window
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An Overview of Filing >  Completing an Electronic Filing
2. In the Case field, type the number of the case for which you are entering the filing and press 
the Tab key.

Notice that the case number and title now appear below the menu bar in the File a Document 
window. In addition, the case number and title appear in the Case Selection box in the lower 
part of the window. The highlighted areas in Figure 14 indicate where the case information 
appears.

Figure 14. File a Document Window With Case Information
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An Overview of Filing >  Completing an Electronic Filing
3. If other case numbers appear in the Case Selection box (another example is shown in 
Figure 15), make sure that you select the checkboxes for those cases where you also want to 
enter your filing. 

You are now ready to find the filing type so you can enter your filing.

4. Use the information in “Finding and Selecting the Filing Type” on page 30 to make your 
selections to identify the type of filing you are entering.

5. Click the Continue button.

Depending on the type of filing you selected, a warning dialog box may open. If this happens, 
carefully review the information in the dialog box, select the appropriate Continue 
checkboxes, and click the OK button.

A screen opens where you enter details about the filing. 

6. Use the information in the topics below to determine how to complete the different areas in the 
screen.

• “Selecting the Filing Party” on page 31

• “Selecting Reliefs for a Filing” on page 32

• “Selecting Related Previous Entries for a Filing” on page 34

• “Attaching PDF Documents to Filings” on page 36

• “Checking the Service List for a Case” on page 39

Figure 15. Multiple Cases in Case Selection Box
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An Overview of Filing >  Completing an Electronic Filing
7. After you complete information in a details screen, click the Continue button.

If more information is needed for the filing, another details screen opens. In this case, fill in the 
necessary information and click the Continue button again.

When you have entered all the information for the filing, and you have clicked the Continue 
button, the Docket Text dialog box opens. An example of the Docket Text dialog box, for a 
response opposing a motion, is shown in Figure 16.

The Docket Text dialog box shows you the text of the entry as it will appear on the docket once 
you complete the filing. You cannot change the text in this dialog box. 

TIP: If you realize that you need to make changes to the filing, you can click the Back button 
to step back in the filing.

Figure 16. Docket Text Dialog Box
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An Overview of Filing >  Completing an Electronic Filing
8. Click the Continue button.

The Event Review dialog box opens. Even though the background of the window is white, you 
cannot change the text in this dialog box. An example of the Event Review dialog box is shown 
in Figure 17.

CAUTION: This is the “point of no return.” 

TIP: If you realize that you need to make changes to the filing, you can click the Back button 
to step back in the filing.

9. Click the Submit button to confirm your filing.

The Event Docketed message dialog box, shown in Figure 18, opens. 

Figure 17. Event Review Dialog Box

Figure 18. Event Docketed Dialog Box
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An Overview of Filing >  Completing an Electronic Filing
10. Click the OK button.

A browser window opens with the notice of docket activity for your filing. An example of a 
browser window with a notice of docket activity is shown in Figure 19.

TIP: If you are not seeing the notice in a new browser window, check your pop-up blocker 
settings. You must allow pop-ups from the Court’s site.

This completes the filing process. 

Figure 19. Notice of Docket Activity for Filing
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An Overview of Filing >  Finding and Selecting the Filing Type
Finding and Selecting the Filing Type
The File a Document window has two areas that let you select the type of filing. Those areas are 
highlighted in Figure 20. This document refers to the area on the left as the categories list, and the 
area on the right as the filing types list. The filing types list is labeled Select One.

When you click a category in the categories list, a list of filing types appears in the area labeled 
Select One. 

For example, to file a response to a motion, you would select the Motions/Responses/Replies 
radio button in the categories list, and then select the File a Response to a Motion in the filing 
types list.

Figure 20. Filing Type
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An Overview of Filing >  Selecting the Filing Party
Selecting the Filing Party
When you file a document, you will have to identify the parties that you represent in the appeal. If 
you are a pro se filer, you must identify yourself at this stage of the process. You identify the parties 
in the Party Filer area. The Party Filer area shows a list of all the parties in a case. If you are a 
pro se filer, your name will appear in this area.

Figure 21 shows an example of the Party Filer area without any selections. To select an entry, you 
must click the checkbox to the left of the Filer column. When a filer is selected, a checkmark 
appears in the checkbox and the row is highlighted. In Figure 22, the filer ABC Fiction Team is 
selected.

TIP: You can use the Select All and Clear All buttons to select or clear all the entries in the list in 
the Party Filer area.

Filing Joint Documents
If you are filing a joint document on behalf of multiple parties, select all the parties who joined in 
the document.

Figure 21. Party Filer Area - No Selections

Figure 22. Party Filer Area - Selection Made
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Selecting Reliefs for a Filing
When you file a motion, you must select at least one relief. A relief describes your motion for the 
Court. You select reliefs in the Relief area. 

Figure 23 shows an example of the Relief area without any selections. 

To select a relief

1. From the Category drop-down list, select a category of reliefs.

Selecting a value from the Category drop-down list filters the values available in the 
Description drop-down list. An example of the Category drop-down list, in expanded state, is 
shown in Figure 24.

Figure 23. Relief Area - No Selections

Figure 24. Relief Area - Category Drop-Down List
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2. From the Description drop-down list, select a relief.

An example of the Description drop-down list, in expanded state, is shown in Figure 25.

3. Click the Apply button.

Your selection now appears in the Selected Reliefs list, as shown in Figure 26.

TIP: You can use the Remove button to remove one selected entry, or the Clear All button to 
clear all the entries in the list.

4. To add another relief, repeat Step 1 - Step 3.

Figure 25. Relief Area - Description Drop-Down List

Figure 26. Relief Area - Relief Selected
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Selecting Related Previous Entries for a Filing
In some types of filings, such as responses, you may be required to select the entry to which your 
filing applies. You do this using the Related Previous Entries area.

Figure 23 shows an example of the Related Previous Entries area without any selections. You can 
click the document icon in the Doc column to see the document that is attached to the entry on the 
Court’s docket. You may have to log in to PACER if you are not already logged in.

To select a previous entry

1. In the list of entries, click the entry to which your filing applies.

The system highlights your selection. In Figure 28, the second entry in the list is highlighted.

Figure 27. Related Previous Entries Area - No Selections

Figure 28. Related Previous Entries Area - Entry Highlighted
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2. Click the Add button.

The system adds your selection to the Selected Entries list. An example is shown in Figure 29.

TIP: You can use the Remove button to remove one selected entry, or the Clear All button to clear 
all the entries in the list.

Figure 29. Related Previous Entries Area - Selected Entries List
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Attaching PDF Documents to Filings
In ECF, you must always attach a PDF when you file a document. You attach documents to an 
event using the PDF Document area, shown in Figure 30.

To attach a document
1. In the PDF Document area, click the Browse button.

The Select PDF document dialog box opens. An example of this dialog box is shown in 
Figure 31. By default, the Select PDF document dialog box points to the last location you 
accessed to attach documents from within ECF.

2. Navigate to and select the PDF file you want to attach.

Figure 30. PDF Document Area

Figure 31. Select PDF document Dialog Box
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3. Click the Open button.

The Select PDF document dialog box closes and ECF shows the file you selected, with the full 
path, in the Document field. The default Description for the document is Main Document. 
An example is shown in Figure 32.

4. To attach another document, such as the certificate of service or a declaration in support of a 
motion, click the Add Another button.

NOTE: The certificate of service does not need to be a separate document. The certificate of 
service can be part of the main document that you attach to the filing.

The PDF Document area expands to include another Document field, another Browse button, 
and a Description field for the second document, as shown in Figure 33.

5. Click the Browse button that was just added.

6. In the Select PDF document dialog box, navigate to and select the next PDF file you want to 
attach.

7. Click the OK button.

8. In the Description field next to the file that you just added, type a description for the 
attachment.

Figure 32. PDF Document Area With One Document Selected

Figure 33. PDF Document Area After Clicking Add Another
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TIP: If you attached a certificate of service, you could type Certificate of Service, 
as shown in the example in Figure 34.

9. To attach another document, return to Step 4 on page 37.

Figure 34. PDF Document Area With Description Field Completed For Standard Form
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Checking the Service List for a Case
Before you file a document, make sure you review the service list for the case or cases so you know 
which attorneys or parties to serve by US Mail. You can check the service list for a case at any time.

TIP: If you find that you cannot access the service list for a case, a pop-up blocker may be at work 
in your browser. The best way to check is to turn on the sound on your system, then try to access 
the Service List (Reports > Service List) or the Help (Help > Help), you should hear a distinctive 
little “ding” which indicates that there is something blocking a web page from opening. Make sure 
you change the pop-up blocker settings to allow all pop-ups from our site.

To check the service list for a case
1. From the Reports menu, choose Service List.

A new browser window opens. An example of what appears in the page is shown in Figure 35.

2. In the Case Number field, type the case number.

Figure 35. Request Service List Page
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3. Click the Show Service List button.

The service list for the case is shown in the browser window. An example of the report is shown 
in Figure 36.

• If the word Active is in the ECF Filing Status column, then your electronic filing will 
constitute service to the party.

• If a hyphen (-) or the word Exempt, or Pending, or Rejected, or Suspended is in the ECF 
Filing Status column, then you must serve this party by US Mail.

Figure 36. Service List for a Case
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Review by the Court

Before you start, make sure you review the information in “An Overview of Filing” on page 23, to 
familiarize yourself with the process of filing something in ECF.

Follow the instructions in this topic to submit a brief for review by the Court.

1. In the Startup Page window, from the menu bar, choose Docketing > File a Document.

The File a Document window opens.

2. In the upper part of the window, in the Case field, type the case number and press the Tab key.

TIP: Notice that the case number and title now appear below the menu bar in the File a 
Document window. In addition, the case number and title appear in the Case Selection box in 
the lower part of the window.

3. In the categories list, select the Briefs radio button.

The right part of the window is updated to show a list of possible filings in the Briefs category.

4. In the list labeled Select One, select the Submit Brief for Review by the Court radio button.
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5. If other case numbers appear in the Case Selection box (an example is shown in Figure 37), 
make sure that you select the checkboxes for those cases where you want to enter your filing. 

NOTE: No matter what type of association is shown in parentheses next to the additional cases, 
if a case is selected, the filing will be done in the case.

6. Click the Continue button.

A dialog box opens with a number of warnings. An example of that dialog box is shown in 
Figure 38.

Figure 37. Multiple Cases in Case Selection Box

Figure 38. Submit Brief for Review by the Court - Warning Dialog Box
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7. For each warning message, read the warning, and select the Continue checkbox button on the 
right to confirm that you have read the message.

CAUTION: If you read a warning and realize that you need to edit your brief, then do not 
continue with this event. In this case, click the OK button without selecting the checkboxes.

Figure 39 shows an example of the warning dialog box with all the Continue checkboxes 
selected.

8. When you have complied with all the warnings and selected all the Continue checkboxes, click 
the OK button.

A screen opens where you must enter additional information about the brief that you are 
submitting.

9. In the Party Filer area, select the party or parties you represent by selecting the checkbox to 
the left of the Filer column.

NOTE: If you are a Pro Se filer, select your name in the list.

See “Selecting the Filing Party” on page 31 for step-by-step instructions.

10. From the Type of Brief drop-down list, select the correct value.

11. In the Service Date field, type the date of service.

Figure 39. Submit Brief for Review by the Court - Warning Dialog Box - Ready to Continue
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TIP: Remember to review the service list for the case by choosing Reports > Service List. 
Follow the step-by-step instructions in “Checking the Service List for a Case” on page 39.

12. In the PDF Document area, click the Browse button to navigate to and select the PDF 
document of your brief.

13. If you need to attach a separate document, such as a certificate of service, do the following:

a. In the PDF Document area, click the Add Another button.

b. Click the Browse button to navigate to and select the PDF document of the certificate of 
service.

c. In the Description field, type the description of the document.

For step-by-step instructions, see “Attaching PDF Documents to Filings” on page 36.

14. Click the Continue button at the bottom of the screen.

The Docket Text dialog box opens. This dialog box shows you the text of the entry as it will 
appear on the docket once you complete the filing. You cannot change the text in this dialog 
box. 

15. Click the Continue button.

The Event Review dialog box opens. Even though the background of the window is white, you 
cannot change the text in this dialog box.

CAUTION: This is the “point of no return.” If you made a mistake, click the Back button to step 
back in the filing.

16. Click the Submit button to confirm your filing.

The Event Docketed message dialog box opens.

17. Click the OK button.

A browser window opens with the notice of docket activity for your filing.
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5 Filing a Motion

Before you start, make sure you review the information in “An Overview of Filing” on page 23, to 
familiarize yourself with the process of filing something in ECF.

Follow the instructions in this topic to file a motion.

1. In the Startup Page window, from the menu bar, choose Docketing > File a Document.

The File a Document window opens.

2. In the upper part of the window, in the Case field, type the case number and press the Tab key.

TIP: Notice that the case number and title now appear below the menu bar in the File a 
Document window. In addition, the case number and title appear in the Case Selection box in 
the lower part of the window.

3. In the categories list, select the Motions/Responses/Replies radio button.

The right part of the window is updated to show a list of possible filings in the Motions/
Responses/Replies category.

4. In the list labeled Select One, select the File a Motion radio button.
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5. If other case numbers appear in the Case Selection box (an example is shown in Figure 40), 
make sure that you select the checkboxes for those cases where want to enter your filing. 

NOTE: No matter what type of association is shown in parentheses next to the additional cases, 
if a case is selected, the filing will be done in the case.

6. Click the Continue button.

A dialog box opens with a number of warnings. An example of that dialog box is shown in 
Figure 41.

7. Read the warning and select the Continue checkbox button on the right to confirm that you 
have read the message.

8. Click the OK button.

A screen opens where you must enter additional information about the filing.

Figure 40. Multiple Cases in Case Selection Box

Figure 41. File a Motion - Warning Dialog Box
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9. In the Party Filer area, select the party or parties you represent by selecting the checkbox to 
the left of the Filer column.

NOTE: If you are a Pro Se filer, select your name in the list.

See “Selecting the Filing Party” on page 31 for step-by-step instructions.

10. If this is not a standard motion, select a value from the Optional Modifier For Motion drop-
down list.

11. In the Relief area, select the relief that describes the motion.

See “Selecting Reliefs for a Filing” on page 32 for step-by-step instructions.

12. Click the Continue button.

Another screen opens where you must enter more information about the filing.

13. In the Service Date field, type the date of service.

TIP: Remember to review the service list for the case by choosing Reports > Service List. 
Follow the step-by-step instructions in “Checking the Service List for a Case” on page 39.

14. In the PDF Document area, click the Browse button to navigate to and select the PDF 
document of your motion.

15. If you need to attach a separate document, such as a certificate of service or a declaration in 
support of the motion, do the following:

a. In the PDF Document area, click the Add Another button.

b. Click the Browse button to navigate to and select the PDF document of the certificate of 
service.

c. In the Description field, type the description of the document.

For step-by-step instructions, see “Attaching PDF Documents to Filings” on page 36.

16. Click the Continue button at the bottom of the screen.

The Docket Text dialog box opens. This dialog box shows you the text of the entry as it will 
appear on the docket once you complete the filing. You cannot change the text in this dialog 
box. 
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17. Click the Continue button.

The Event Review dialog box opens. Even though the background of the window is white, you 
cannot change the text in this dialog box.

CAUTION: This is the “point of no return.” If you made a mistake, click the Back button to step 
back in the filing.

18. Click the Submit button to confirm your filing.

The Event Docketed message dialog box opens.

19. Click the OK button.

A browser window opens with the notice of docket activity for your filing.
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6 Filing a Motion and a 
Response to a Motion 
Together

Before you start, make sure you review the information in “An Overview of Filing” on page 23, to 
familiarize yourself with the process of filing something in ECF.

Follow the instructions in this topic to file a motion and a response to a motion in one filing (and 
one document).

1. In the Startup Page window, from the menu bar, choose Docketing > File a Document.

The File a Document window opens.

2. In the upper part of the window, in the Case field, type the case number and press the Tab key.

TIP: Notice that the case number and title now appear below the menu bar in the File a 
Document window. In addition, the case number and title appear in the Case Selection box in 
the lower part of the window.

3. In the categories list, select the Motions/Responses/Replies radio button.

The right part of the window is updated to show a list of possible filings in the Motions/
Responses/Replies category.

4. In the list labeled Select One, select the File a Motion and a Response to a Motion Together 
radio button.
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5. If other case numbers appear in the Case Selection box (an example is shown in Figure 42), 
make sure that you select the checkboxes for those cases where you want to enter your filing. 

NOTE: No matter what type of association is shown in parentheses next to the additional cases, 
if a case is selected, the filing will be done in the case.

6. Click the Continue button.

A dialog box opens with a number of warnings. An example of that dialog box is shown in 
Figure 43.

7. For each warning message, read the warning, and select the Continue checkbox button on the 
right to confirm that you have read the message.

8. When you have selected all the Continue checkboxes, click the OK button.

A screen opens where you must enter additional information about the filing.

Figure 42. Multiple Cases in Case Selection Box

Figure 43. File a Motion and a Response to a Motion Together- Warning Dialog Box
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9. In the Party Filer area, select the party or parties you represent by selecting the checkbox to 
the left of the Filer column.

NOTE: If you are a Pro Se filer, select your name in the list.

See “Selecting the Filing Party” on page 31 for step-by-step instructions.

10. If this is not a standard motion, select a value from the Optional Modifier For Motion drop-
down list.

11. In the Relief area, select the relief that describes the motion.

See “Selecting Reliefs for a Filing” on page 32 for step-by-step instructions.

12. Click the Continue button.

A screen opens with two areas: Additional Information and Related Previous Entries. An 
example is shown in Figure 44.

13. From the Response Type drop-down list, select the value that matches the type of response you 
are filing.

Figure 44. Additional Information and Related Previous Entries Areas
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14. Use the controls in the Related Previous Entries area to select the motion for which you are 
filing a response.

See “Selecting Related Previous Entries for a Filing” on page 34 for step-by-step instructions 
for selecting the previous filing for which you are filing a response.

15. Click the Continue button.

Another screen opens where you must enter more information about the filing.

16. In the Service Date field, type the date of service.

TIP: Remember to review the service list for the case by choosing Reports > Service List. 
Follow the step-by-step instructions in “Checking the Service List for a Case” on page 39.

17. In the PDF Document area, click the Browse button to navigate to and select the PDF 
document of your motion.

18. If you need to attach a separate document, such as a certificate of service or a declaration in 
support of the motion, do the following:

a. In the PDF Document area, click the Add Another button.

b. Click the Browse button to navigate to and select the PDF document of the certificate of 
service.

c. In the Description field, type the description of the document.

For step-by-step instructions, see “Attaching PDF Documents to Filings” on page 36.

19. Click the Continue button at the bottom of the screen.

The Docket Text dialog box opens. This dialog box shows you the text of the entry as it will 
appear on the docket once you complete the filing. You cannot change the text in this dialog 
box. 

20. Click the Continue button.

The Event Review dialog box opens. Even though the background of the window is white, you 
cannot change the text in this dialog box.

CAUTION: This is the “point of no return.” If you made a mistake, click the Back button to step 
back in the filing.

21. Click the Submit button to confirm your filing.

The Event Docketed message dialog box opens.
52 - ECF User Guide



Filing a Motion and a Response to a Motion Together >  
22. Click the OK button.

A browser window opens with the notice of docket activity for your filing.
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7 Working With Email 
Notices of Docket 
Activity

The topics below describe the notice of docket activity and explain how to save a copy of the 
documents attached to the notice.

• “What is in a Notice of Docket Activity?” on page 56

• “The Subject Line of a Notice of Docket Activity” on page 57

• “Document Links in a Notice of Docket Activity” on page 58
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What is in a Notice of Docket Activity?
A notice of docket activity is a notice that is generated whenever something is entered on the docket 
of a case. The top of the notice contains a disclaimer stating that public users may view the notice 
information once free of charge (“one free look”). After that, a fee will be assessed.

NOTE: If you are not a party or attorney in a case, and you signed up to receive notices for cases 
of interest, the “one free look” does not apply. 

The notice shows case information, docket text, the recipient names, and a hyperlink for the case 
number. In addition, the notice may include a link labeled Document(s). If you are logged in to 
PACER, clicking the case number hyperlink takes you to the Docket Report window from where 
you can generate a docket report. “Document Links in a Notice of Docket Activity” on page 58 
explains how the document links work. 

An example of a browser window with a notice of docket activity is shown in Figure 45.

Figure 45. Notice of Docket Activity for Filing
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The Subject Line of a Notice of Docket Activity
The subject line of a notice of docket activity shows the case number, the case title, and provides 
a short description of the activity that happened in the case.

Even if the notice applies to several cases, the subject line of a notice of docket activity only lists 
one case number! An example of this is a notice of oral argument. Usually, a notice of oral 
argument notice applies to all the cases that are scheduled to be heard on the same day, but only 
one case number will appear in the subject line of the notice of docket activity. The docket text 
includes information to let you know that you must open the documents attached to the notice to 
view details about your case. An example of docket text for a notice of oral argument is shown 
below.

Notice of Oral Argument on AUGUST Calendar. Please return 
ACKNOWLEDGEMENT OF HEARING NOTICE form to: SEATTLE Office. 
Attention: The Notice of Docket Activity may not list your case 
number. Please open attached documents to view details about 
your case. [07-30344, 07-30452, 07-30458, 07-30459, 07-35188, 
07-35341, 07-35610, 07-35841, 07-35907] 
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Document Links in a Notice of Docket Activity
A Document(s) link appears in the notice if one or more documents were attached to the activity 
in the docket.

You can click the Document(s) link to view the document or documents that were attached.

In ECF documents are attached in portable document format (PDF). This means that when you 
click a document link, the document opens in Adobe Reader or in another PDF-capable application 
on your system. For the purpose of this guide, we will assume that you are using Adobe Reader.

NOTE: If you are not a party or attorney in a case, and you signed up to receive notices for cases 
of interest, the “one free look” does not apply. 

To save a copy of a document attached to a notice of docket activity
1. In the notice of docket activity, click the Document(s) link.

NOTE: If more than one document is attached to the entry, a page opens with a number of links. 
There is one link for each attached document. In this case, click the link of the document that 
you want to open.

The document opens in your web browser or in a separate Adobe Reader window, depending 
on your settings. 

2. Choose File > Save As (or Save A Copy, if Save As is not shown). 

-or-

Click the Save a Copy button in the toolbar.

3. In the Save As dialog box, enter the file name and location, and click the Save button. 
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8 Creating 
Cross-Document 
Hyperlinks

The topics below describe how to create a hyperlink in a PDF document, where the hyperlink links 
to another PDF document in a CM/ECF database. The document being referenced can be a 
document that was previously filed or a document that is being filed in the same transaction (filing) 
as the referencing document. The steps to create a hyperlink and to generate documents in PDF 
format are similar whether you are using WordPerfect or Word to create documents; differences are 
noted as needed.

• “Creating a Hyperlink to a Document Already Filed in a Case” on page 60

• “Creating Hyperlinks Between Documents in the Same Filing” on page 64
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Creating a Hyperlink to a Document Already 
Filed in a Case
You can create a link to another document in any database in the Federal Courts: District, 
Bankruptcy (as of December 2006) or Appellate (as of July 2006, Version 1.3).

1. Access CM/ECF and run the docket report for the case in which the document was filed.

2. Locate the document among the docket entries.

3. Copy the URL (the “address”) of the document to the clipboard by doing the following:

a. Hover over the document link and click the right mouse button (the document link displays 
after the docket date and is represented by an icon or a number with an underscore, for 
example, 5).

b. From the pop-up menu, choose Copy Shortcut or Copy Link Location (the option you 
will see depends on your browser),

CAUTION: DO NOT copy the URL from the browser’s address bar when the document is 
open.

An example of the pop-up menu in Internet Explorer is shown in Figure 46.

4. Open the word processing document.

Figure 46. Pop-up Menu for Document in Docket Report
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5. In the document, highlight the citation text for which you want to create the hyperlink.

An example is shown in Figure 47.

6. If you are using WordPerfect, go to: “To create the hyperlink and produce a PDF in 
WordPerfect” below.

-or-

If you are using Word, go to: “To create the hyperlink and produce a PDF in Word” on page 62.

To create the hyperlink and produce a PDF in WordPerfect
1. From the Tools menu, choose Hyperlink.

The Hyperlink Properties dialog box opens. An example is shown in Figure 48.

2. Press Ctrl-V to paste the URL into the Document/Macro field.

Figure 47. Highlight Hyperlink Text

Figure 48. Hyperlink Properties Dialog Box
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3. If the citation is to a specific page in the document, append a string to the URL to identify the 
page: ?page=x 
For example: 
https://ecf.ca1.uscourts.gov/docs1/001010708409?page=23 

NOTE: Because of an incompatibility between Internet Explorer and Adobe Acrobat, the page 
number pointer will not work if the user opens the document with Internet Explorer.

4. Click the OK button.

In the word processing application, the hyperlink text is now underlined and blue (or the color 
that you specified for hyperlinks), indicating a hyperlink has been created. 

5. Save the word processing document.

6. Produce the PDF file.

CAUTION: Do not use the Print option in the word processing program.

If you are using a version of WordPerfect that has a Publish to PDF or Publish to option on 
the File menu, choose Publish to PDF or choose Publish to, then choose PDF. 

NOTE: If you are using an earlier version of WordPerfect that does not have one of these 
Publish options, you must upgrade to Version 11 or higher.

You are now ready to file your document and upload the PDF with hyperlinks.

To create the hyperlink and produce a PDF in Word
1. From the Insert menu, choose Hyperlink.

The Insert Hyperlink dialog box opens. An example is shown in Figure 49.

Figure 49. Insert Hyperlink Dialog Box
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2. Press Ctrl-V to paste the URL into the Address field.

3. If the citation is to a specific page in the document, append a string to the URL to identify the 
page: ?page=x 
For example: 
https://ecf.ca1.uscourts.gov/docs1/001010708409?page=23 

NOTE: Because of an incompatibility between Internet Explorer and Adobe Acrobat, the page 
number pointer will not work if the user opens the document with Internet Explorer.

4. Click the OK button.

In the word processing application, the hyperlink text is now underlined and blue (or the color 
that you specified for hyperlinks), indicating a hyperlink has been created. 

5. Save the word processing document.

6. Produce the PDF file by following the steps below. 

CAUTION: Do not use the Print option in the word processing program.

If you are using a version of Word that has an Adobe PDF menu, choose the Convert to Adobe 
PDF option.

If you are using Word but do not have an Adobe PDF menu, close the Word file and follow the 
steps below. 

a. Open Adobe Acrobat. 

b. From the File menu, choose Create PDF > From File.

A navigation dialog box opens. 

c. In the navigation dialog box, find and select the document that you want to convert to PDF, 
then click the Open button.

A series of dialog boxes open while the document is converted to PDF. When the 
conversion is complete, the document is displayed in an Adobe Acrobat window, with 
active hyperlinks (the ones you defined in the Word document).

d. Save the PDF file in a directory of your choice.

You are now ready to file your document and upload the PDF with hyperlinks.
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Creating Hyperlinks Between Documents in the 
Same Filing
Instead of linking to a previously-filed document, you can link a document to another document 
that you will be filing at the same time. For example, you could create a hyperlink from your main 
document to an attachment. 

When you create the link, it points to the referenced document where it exists on your local system 
or network and when the documents are filed in CM/ECF, the link is converted to an “address” in 
CM/ECF.

1. Create PDF versions of any secondary documents, such as attachments or exhibits, that will be 
referenced by the main document. 

2. Open the main document in the word processing program.

The main document is the document that will have hyperlinks to the secondary documents.

3. In the main document, highlight the text for which you want to create the hyperlink to the 
secondary document.

4. If you are using WordPerfect, go to: “To create the hyperlink to an attachment and produce a 
PDF in WordPerfect” below.

-or-

If you are using Word, go to: “To create the hyperlink to an attachment and produce a PDF in 
Word” on page 66.

To create the hyperlink to an attachment and produce a PDF in WordPerfect
1. From the Tools menu, choose Hyperlink.

The Hyperlink Properties dialog box opens. An example is shown in Figure 50.

Figure 50. Hyperlink Properties Dialog Box
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2. Click the folder icon to the right of the Document/Macro field.

The Select File window opens.

3. Navigate to and select the PDF file that you want to link to and click the Select button.

The Document/Macro field in the Hyperlink Properties dialog box now shows the file you 
selected.

4. Click the OK button.

5. If the citation is to a specific page in the document, append a string to the value in the field to 
identify the page: ?page=x 
For example: 
C:\MyFiles\Exhibit-A.pdf?page=23 

NOTE: Because of an incompatibility between Internet Explorer and Adobe Acrobat, the page 
number pointer will not work if the user opens the document with Internet Explorer.

6. Click the OK button.

In the word processing application, the hyperlink text is now underlined and blue (or the color 
that you specified for hyperlinks), indicating a hyperlink has been created. 

7. Save the word processing document.

8. Produce the PDF file.

CAUTION: Do not use the Print option in the word processing program.

If you are using a version of WordPerfect that has a Publish to PDF or Publish to option on 
the File menu, choose Publish to PDF or choose Publish to, then choose PDF. 

NOTE: If you are using an earlier version of WordPerfect that does not have one of these 
Publish options, you must upgrade to Version 11 or higher.

You are now ready to file your documents and upload the PDF with hyperlinks.
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To create the hyperlink to an attachment and produce a PDF in Word
1. From the Insert menu, choose Hyperlink.

The Insert Hyperlink dialog box opens. An example is shown in Figure 51.

2. Navigate to and select the PDF file that you want to link to.

3. The Address field in the Insert Hyperlink dialog box now shows the file you selected.

4. If the citation is to a specific page in the document, append a string to the value in the field to 
identify the page: ?page=x 
For example: 
C:\MyFiles\Exhibit-A.pdf?page=23 

NOTE: Because of an incompatibility between Internet Explorer and Adobe Acrobat, the page 
number pointer will not work if the user opens the document with Internet Explorer.

5. Click the OK button.

In the word processing application, the hyperlink text is now underlined and blue (or the color 
that you specified for hyperlinks), indicating a hyperlink has been created. 

6. Save the word processing document.

Figure 51. Insert Hyperlink Dialog Box
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7. Produce the PDF file by following the steps below. 

CAUTION: Do not use the Print option in the word processing program.

If you are using a version of Word that has an Adobe PDF menu, choose the Convert to Adobe 
PDF option.

If you are using Word but do not have an Adobe PDF menu, close the Word file and follow the 
steps below. 

a. Open Adobe Acrobat. 

b. From the File menu, choose Create PDF > From File.

A navigation dialog box opens. 

c. In the navigation dialog box, find and select the document that you want to convert to PDF, 
then click the Open button.

A series of dialog boxes open while the document is converted to PDF. When the 
conversion is complete, the document is displayed in an Adobe Acrobat window, with 
active hyperlinks (the ones you defined in the Word document).

d. Save the PDF file in a directory of your choice.

You are now ready to file your documents and upload the PDF with hyperlinks.
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9 Filing Categories and 
Types of Motions

This chapter provides a complete list of the ECF filing categories and types of motions you can file. 

• “Briefs” on page 70

• “Motions/Responses/Replies” on page 72

• “Rehearing/Reconsideration” on page 76

• “Transcripts/Court Reporters” on page 77

• “Answers to Original Petitions” on page 78

• “Appeals Pursuant to FRAP 9(a)” on page 79

• “Forms/Notices/Disclosures” on page 80

• “Correspondence/Status Reports” on page 81

• “Prospective Amici and Intervenors” on page 82
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Briefs
An example of part of the File a Document window with the Briefs category selected is shown in 
Figure 52.

• Submit Brief for Review by the Court

• Submit Brief for Review and File a Motion Together
For a list of the types of motions that you can file, see “Types of Motions Available When 
Submitting a Brief and Filing a Motion Together” on page 71.

• File an Errata to a Brief

• File a Citation of Supplemental Authorities (FRAP 28(j) Letters)

• File a Notice of Joint Brief Under 9th Cir. R. 28-4 (Form 7)

Figure 52. Filing Category: Briefs
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Types of Motions Available When Submitting a Brief and Filing a 
Motion Together
You select the type of motion using the Relief area. “Selecting Reliefs for a Filing” on page 32 
provides step-by-step instructions on how to use the Relief area.

• motion to file a late brief

• motion to file nonstandard brief

• motion to file oversized brief

• motion to file substitute or corrected brief

• motion to file supplemental brief

• motion to reinstate case

• motion to withdraw as counsel
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Motions/Responses/Replies
An example of part of the File a Document window with the Motions/Responses/Replies category 
selected is shown in Figure 53.

• File a Motion. For a list of the types of motions that you can file, see “Types of Motions 
Available When Filing a Motion” on page 73.

• File a Response to a Motion

• File a Motion and a Response to a Motion Together. For a list of the types of motions that you 
can file, see “Types of Motions Available When Filing a Motion” on page 73.

• File a Reply to a Response to a Motion

• File a Response to an Order to Show Cause

• File a Reply to a Response to an Order to Show Cause

• File a Motion for Reconsideration from Dispositive Order

• File a Motion for Reconsideration from Non-Dispositive Order

• Submit Brief for Review and File a Motion Together. See “Briefs” on page 70 for additional 
information.

• File a Court Reporter Motion. See “Transcripts/Court Reporters” on page 77 for additional 
information.

• File an Answer to an Original Petition

Figure 53. Filing Category: Motions/Responses/Replies
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Types of Motions Available When Filing a Motion
You select the type of motion using the Relief area. “Selecting Reliefs for a Filing” on page 32 
provides step-by-step instructions on how to use the Relief area.

• motion for 46-5 exemption

• motion for appointment of counsel

• motion for appointment of pro bono counsel

• motion for attorney fees

• motion for bail pending appeal or trial

• motion for certificate of appealability

• motion for certification to state supreme court

• motion for injunction pending appeal

• motion for miscellaneous relief (to be used only if no other relief applies)

• motion for sanctions

• motion for summary affirmance

• motion for summary disposition

• motion for summary reversal

• motion to assign case to prior panel

• motion to compel supplementation of excerpts of record

• motion to complete production of reporters transcript at government expense

• motion to consolidate cases

• motion to continue hearing

• motion to dismiss case for failure to prosecute under Circuit Rule 42-1

• motion to dismiss for lack of jurisdiction

• motion to dismiss party from case

• motion to dismiss the case

• motion to dismiss the case voluntarily pursuant to rule 42b

• motion to expedite case

• motion to extend time to comply with order
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• motion to extend time to file CADS

• motion to extend time to file COA request

• motion to extend time to file agency record

• motion to extend time to file appellant designation of reporters transcript

• motion to extend time to file appellee designation of reporters transcript

• motion to extend time to file appendix

• motion to extend time to file bill of costs

• motion to extend time to file brief

• motion to extend time to file opposition

• motion to extend time to file petition for rehearing

• motion to extend time to file record on appeal

• motion to extend time to file reply

• motion to extend time to file response

• motion to file addendum

• motion to file appendix

• motion to file joint brief

• motion to file late opposition (to file motion and opposition together)

• motion to file late petition for rehearing (to file motion and petition for rehearing together)

• motion to file oversized petition for rehearing

• motion to file substitute or corrected brief

• motion to file supplemental brief

• motion to file supplemental briefing for petition for rehearing

• motion to file supplemental excerpts of record

• motion to hear case with other case

• motion to join in existing brief

• motion to lift stay

• motion to present oral argument by video

• motion to proceed in forma pauperis
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• motion to recall mandate

• motion to refer case to mediation

• motion to reinstate case

• motion to remand case

• motion to request publication of memorandum disposition

• motion to reschedule oral argument

• motion to stay lower court action

• motion to stay proceedings

• motion to stay proceedings pending settlement

• motion to stay removal/deportation

• motion to stay the mandate

• motion to strike portion or whole of document

• motion to submit case on briefs

• motion to substitute counsel

• motion to substitute party

• motion to supplement or amend Civil Appeals Docketing Statement

• motion to supplement or amend designation of reporters transcript

• motion to supplement record on appeal

• motion to take judicial notice

• motion to transfer appeal to other circuit

• motion to unseal document

• motion to waive filing of CADS

• motion to waive filing of excerpts of record

• motion to withdraw as counsel
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Rehearing/Reconsideration
An example of part of the File a Document window with the Rehearing/Reconsideration category 
selected is shown in Figure 54.

• File a Petition for Panel Rehearing (FRAP 40; 9th Cir. R. 40-1)

• File a Petition for Rehearing En Banc (FRAP 35; 9th Cir. R. 35-1)

• File a Combination Petition for Panel Rehearing/En Banc (FRAP 35, 40)

• File an Answer or Response to a Petition for Rehearing/En Banc

• File a Reply to an Answer to a Petition for Rehearing/En Banc

• File a Motion for Reconsideration from Dispositive Order

• File a Motion for Reconsideration from Non-Dispositive Order

Figure 54. Filing Category: Rehearing/Reconsideration
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Transcripts/Court Reporters
An example of part of the File a Document window with the Transcripts/Court Reporters 
category selected is shown in Figure 55.

• File a Court Reporter Motion
For a list of the types of motions that you can file, see “Types of Motions Available When Filing 
a Court Reporter Motion,” below.

• File Transcript Designation (9th Cir. R. 10-3)

• File Court Reporter Correspondence to Court

• File a Notice of Reporter Default (9th Cir. R. 11-1.2)

Types of Motions Available When Filing a Court Reporter Motion
You select the type of motion using the Relief area. “Selecting Reliefs for a Filing” on page 32 
provides step-by-step instructions on how to use the Relief area.

• motion to extend time to file reporters transcript

Figure 55. Filing Category: Transcripts/Court Reporters
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Answers to Original Petitions
An example of part of the File a Document window with the Answers to Original Petitions 
category selected is shown in Figure 56.

• File an Answer to an Original Petition

Figure 56. Filing Category: Answers to Original Petitions
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Appeals Pursuant to FRAP 9(a)
An example of part of the File a Document window with the Appeals Pursuant to FRAP 9(a) 
category selected is shown in Figure 57.

• File a FRAP 9(a) Memorandum

• File a Response to a FRAP 9(a) Memorandum

• File a Reply to a Response to a FRAP 9(a) Memorandum

Figure 57. Filing Category: Appeals Pursuant to FRAP 9(a)
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Forms/Notices/Disclosures
An example of part of the File a Document window with the Forms/Notices/Disclosures category 
selected is shown in Figure 58.

TIP: You can download fill-in forms from the Court’s website. 
Go to http://www.ca9.uscourts.gov/, click the Downloads link, then click the arrow icon to the left 
of Forms and Guidelines. You must have Adobe Acrobat to save a fill-in form. If you do not have 
Adobe Acrobat, fill in the form, print the form, and then scan it so you can attach it to your filing.

• File a Notice of Appearance or Re-Assignment

• File a Civil Appeals Docketing Statement (Form 6)

• File Affidavit Accompanying In Forma Pauperis Motion (Form 4)

• File a CJA Form 23 Financial Affidavit

• File a Corporate Disclosure Statement (FRAP 26.1)

• File a Notice of Joint Brief Under 9th Cir. R. 28-4 (Form 7)

• File a Bill of Costs (Form 10)

• File an Application for Fees Under EAJA

• File a Certification for Law Student Representation Form

• File a Client Authorization of Law School Representation

• File a Notice of Reporter Default (9th Cir. R. 11-1.2)

Figure 58. Filing Category: Forms/Notices/Disclosures
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Correspondence/Status Reports
An example of part of the File a Document window with the Correspondence/Status Reports 
category selected is shown in Figure 59.

• File a Citation of Supplemental Authorities (FRAP 28(j) Letters)

• File a Status Report Required by Court Order

• File Correspondence to Court

• File Court Reporter Correspondence to Court
See “Transcripts/Court Reporters” on page 77 for additional information.

• File a Notice of Reporter Default (9th Cir. R. 11-1.2)

Figure 59. Filing Category: Correspondence/Status Reports
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Prospective Amici and Intervenors
An example of part of the File a Document window with the Prospective Amici and Intervenors 
category selected is shown in Figure 59.

• File a Corporate Disclosure Statement (FRAP 26.1)

• File a Prospective Amicus or Intervenor Motion
For a list of the types of motions that you can file, see “Types of Motions Available When Filing 
a Prospective Amicus or Intervenor Motion,” below.

• Submit Brief and File Prospective Amicus or Intervenor Motion Together
For a list of the types of motions that you can file, see “Types of Motions Available When Filing 
a Prospective Amicus or Intervenor Motion,” below.

Types of Motions Available When Filing a Prospective Amicus or 
Intervenor Motion
You select the type of motion using the Relief area. “Selecting Reliefs for a Filing” on page 32 
provides step-by-step instructions on how to use the Relief area.

• motion to become amicus

• motion to intervene

Figure 60. Filing Category: Prospective Amici and Intervenors
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